

[bookmark: h.elpgnuhvvg6z][bookmark: _GoBack]Introduction to Google Docs: Enabling Student Collaboration
[bookmark: h.1c3as2yulw2n]Getting started with Google documents

Google Docs is an online word processor that lets you create and format text documents and collaborate with other people in real time. You can login to google documents with your google account - or you can create an account by selecting ‘sign up’ at: http://docs.google.com/
Advantages of Google documents
The great advantage to Google documents is that several people can be viewing, editing or commenting on a document simultaneously. All changes are saved automatically and are available and synced in real time. This access to documents from anywhere, along with the sharing feature, makes printing hard copies unnecessary.
Here's what you can do with Google Docs:
· 1. Upload a Word document and convert it to a Google document
· 2. Add formatting to your documents by adjusting margins, spacing, fonts, and colors 
· 3. Invite other people to collaborate on a document with you, giving them edit, comment or view access
· 4. Collaborate online in real time and chat with other collaborators — right from inside the document
· 5. View your document's revision history and go back to any previous version
· 6. Download a Google document  
· 7. Translate a document to a different language
· 8. Email your documents to other people as attachments
[bookmark: h.qpa04243tauf]This Is How To Share
If you want to send a file or folder to someone so they may view, edit, or comment on it, you can share it with them directly in Google Drive, Docs, Sheets, or Slides, or through a link. 
[bookmark: h.oqeog69yy6dk]Sharing a file or folder
You can share a file or folder in Google Drive or in the Docs, Sheets, and Slides home screens. You can also share from any of the Drive, Docs, Sheets, or Slides mobile apps. Anyone you share the file or folder with will see changes made as they happen so that everyone can be on the same page and you can get feedback quickly.

1. Open Drive, or a file or folder you want to share.
2. Open the sharing box:
· While you have a file open: Click Share in the top-right corner.
· While you have a folder open: Click the share icon in the top-right [image: Share].
· From your file list in Drive: Select the name of a file or folder and click the share icon at the top [image: Share].
3. Under “People” in the sharing box, type the email addresses of the people or Google Groups you want to share with. You can also search for contacts by typing them into the box.
4. Choose the type of access you want to give these users by clicking the dropdown arrow to the right of the text box:
· Can edit: Users can edit the file or folder and share it with others
· Can comment: Users can view and add comments or suggestions to the file, but can’t edit it. 
· Can view: Users can see the file or folder but can’t edit or comment on it
5. Click Done. The users will receive an email letting them know you’ve shared the file or folder with them.

[bookmark: h.yg6x8w6lydzw]Sharing a Link to a file or a folder 
To give other people access to a file or folder, you can send them a link to open and access the item.

1. Sign in to Google Drive or a Docs, Sheets, or Slides home screen.
2. Open the file you want to get a link for.
3. Click Share for files or the share icon for folders in the top-right corner of the screen [image: Share].
4. Click Get shareable link in the top-right corner of the sharing box. A link to the file will be copied to your clipboard.
5. Paste the link into an email or chat to share it.
6. To stop allowing people to access the file using the link, open the sharing box > click the dropdown menu below "Link sharing on" > choose OFF > click Done.

By default, the link you share will be “view only” for others. To allow people with the link to comment on or edit the file, click the dropdown menu under "Link sharing on" and change the setting from "People with the link can view" to "People with the link can comment (or can edit)".

Sending a file as an email attachment
While you can email the link to a file just by sharing it in Drive, Docs, Sheets, or Slides, you can also send the file as an email attachment.

1. Sign in to Google Drive or a Docs, Sheets, or Slides home screen.
2. Open the file you'd like to share.
3. Go to the File menu > Email as attachment.
4. Select a file type from the drop-down menu.
5. Enter the email addresses of the people you want to send the file to. You can also add a subject and a message.
6. Click Send.
Differences between type of access
When you share a file or folder with other people, you have the choice to give them viewing and editing access, as well as ownership of the file. While not applicable to folders, you can also give commenting access to files in order to get feedback from the people you're sharing with. You can change this access at any time.
Here’s what people can do in a file or folder as a viewer, commenter, editor, or owner:
	 
	Can view
	Can comment
	Can edit
	Is owner

	View files and folders
	x
	x
	x
	x

	Download or sync files to another device
	x
	x
	x
	x

	Make a copy of files to save in Google Drive
	x
	x
	x
	x

	Comment and suggest edits in files
	 
	x
	x
	x

	Accept or decline suggested edits in files
	
	
	x
	x

	Edit documents, spreadsheets, presentations, and drawings
	 
	 
	x
	x

	Share or unshare files with others
	 
	 
	x
	x

	Add or remove files from a folder
	 
	 
	x
	x

	Upload and delete file versions
	 
	 
	x
	x

	Delete files and folders
	 
	 
	 
	x

	Transfer ownership of files and folders to others
	 
	 
	 
	x


[bookmark: h.9y4757ls6t9s]
[bookmark: h.xe6pov5mm9qn]Changing access for shared files 
After you’ve shared a file with others, you can change the type of access specific people or groups can have.
1. Open the file.
2. Click Share in the top-right corner. 
3. Click Advanced in the bottom-right corner of the sharing box.
4. Using the dropdown menu next to the user’s name, select the type of access you want them to have. Click Save changes button on bottom left corner. [image: Sharing Rights Changed.jpg]
5. Click Done.
[bookmark: h.ohwbqpcdbu41]Removing sharing privileges to editors
By default, people who can edit your file or folder can also share that file or folder with other people. If you are the owner of a file or folder, you can choose to remove editor ability to share files with others. This allows you to control everyone who is able to view or edit the file or folder. You can prevent that by turning on this setting:
1. Select a file or folder.
2. At the top, click the share box [image: ].
3. In the bottom right, click Advanced.
4. Next to "Prevent editors from changing access and adding new people," check the box. [image: Prevent.PNG]
5. Click Done.

If you would like instructions on how to share from an android or iOS please see this link.
[bookmark: h.gw3kjy7j71y]This is How to Add Comments
If you want to have a conversation about the Google Doc that you’re working on, you can leave comments directly in files to ask questions, make notes, or highlight changes you’ve made.
You can then edit or delete your comments, as well as reply to comments made by others and close comment threads when you’re finished with them.
[bookmark: h.7p2i475s6cb8]Adding a comment
1. Open a document, spreadsheet, or presentation.
2. Highlight information you’d like to comment on, like text, images, cells, or slides.
3. Add a comment in one of the following ways:
· Click the [image: ] Comment button in the toolbar.
· Go to the Insert menu > Comment.
· Use the keyboard shortcut Ctrl + Alt + M (Cmd + Option + M on a Mac).
4. Type your comment in the box that appears to the right of the file.
5. [bookmark: h.rsxnuc780vsa]Click Comment to save the comment.
[bookmark: h.7bxkse3rb7c3]Editing or deleting a comment
1. Open the file where you made the comment.
2. Select the comment you want to edit or delete.
3. [bookmark: h.uhmuwqemu0fn]Click Edit or Delete right below your comment text.
[bookmark: h.hyp4pcfb4mci]Reply to a comment
1. Open the file that includes the comment you want to reply to.
2. Select the relevant comment.
3. Click the text box that says “Reply” and add your reply.
4. [bookmark: h.y2amhlxqasc5]Click the Reply button.
[bookmark: h.ttggay4lsz56]Closing a comment
1. Open the file that includes the comment you want to close.
2. Select the relevant comment.
3. Click Resolve in the top-right corner of the comment.
[bookmark: h.jkb3cqtkatgc]If you want to see a comment that you’ve closed, you can find it by clicking Comments in the top-right corner of your file. You can reply to a comment directly from the box or Re-open a closed comment by clicking Re-open in top right corner of the comment. 
[bookmark: h.u5yjmudvr25z]
[bookmark: h.wyhwuy26fnzc]Difference between suggesting edits and commenting
Anyone with "Can comment" or "Can edit" access to a document can leave comments or suggest edits.
	 
	Comments
	Suggested edits

	Instructions:
	Click the Comment button [image: ] in the toolbar
	Switch to [image: ] Suggesting mode in the top-right

	Use examples:
	Ask a question or make a note next to a specific section of existing text
	Suggest new text that you recommend adding or changing in the document

	Next steps:
	Owners and editors can reply to your question or note, or click Resolve to close the comment
	Owners  and editors can accept your suggestions to add as final text or reject the suggestions to erase them




[bookmark: h.3d4fveukwzrl]This is How to Suggest Edits 
If you're proofing a doc and want to suggest changing some text, you can suggest edits to the owner of the document without affecting the original text. Your suggestions won't change the original text until the document owner or editor approves them. Once you are in Suggesting mode, you just need to start typing to begin suggesting edits. FYI - Suggestions can be viewed on Android devices, but can’t be added on mobile devices at this time.
[bookmark: h.6ooghfqv67vx]Offering a suggested edit
1. Open the document.
2. In the top-right corner, make sure you are in Suggesting mode, which may also appear as a [image: ] icon.
[image: ]
3. To suggest an edit, simply begin typing where you think the edit should be made in the document.
4. Your suggestions will appear in a new color and any text you suggest deleting or replacing will be crossed out.
5. Owners of the documents will receive an email with your suggestions and be able to accept or reject them.
[bookmark: h.u2xfxfj1htvd]Explaining a suggested edit you’ve made
To give more detail about a suggested edit you’ve made:
1. Open the document where you made the suggestion.
2. Click your suggested edit and type your comment into the text box that appears.
3. Click Reply.
[bookmark: h.1frutsxgwgrm]Accepting or rejecting a suggested edit in your doc
1. Open the document.
2. Click the comment where the suggestion has been made.
3. Click Accept or Reject in the top-right of the comment:
· [image: ]: Accept the proposed change so that the suggested text is added directly to your document.
· [image: ]: Reject the proposed change so that the suggested text is deleted.
You can see all of the suggested edits that have been accepted or rejected in your document by clicking Comments in the top-right corner of the document. 
[bookmark: h.ojlgwyq7wk5]
[bookmark: h.jndtbelfhcu1]This is How to Set Up Notifications

You can set notifications to find out when other people have made suggestions to the doc, and learn what they've modified. You can also choose how often you'd like to be notified.
[bookmark: h.pzmntpwqvvxh]Setting notifications
1. Open the doc where you want to set notifications.
2. Go to the Comments box and select Notifications.  [image: comments.PNG]
3. In the window that appears, select when and how often you want to receive notifications.
· [bookmark: h.hqp4zqsykny0]When:
· [bookmark: h.w118srxeujj6]“All”
· “Only Yours”
· or “None”
[bookmark: h.48apodbhphq9]This is How to Edit Files 

You can edit a file at the same time as other people with edit access in Google Docs, Sheets, Slides, Forms, and Drawings, whether you’re on your computer or a mobile device. When someone makes an edit, their change will automatically appear on your screen if you’re viewing the file, with their name next to their cursor so that you can see who is typing.
The ability to see edits made by others in real time is only available when you and the others working on the file have an Internet connection.

[bookmark: h.inmj5dwnn0b4]Making edits
To make quick, dynamic edits:
1. Open a spreadsheet and click on a chart.
2. On the right, click the editing mode icon [image: ]
3. [bookmark: h.mzyhr3hbqw01]Click on what you'd like to change in doc and type.
[bookmark: h.7hm8235by0wu]See the history of changes made to a file
If you want to see all of the changes you and others have made to a document, spreadsheet, presentation, or drawing, you can check your revision history. You can view and revert back to earlier versions of your file and see which person made specific edits.
To see revision history for a file, follow these steps:
1. Open a document, spreadsheet, presentation, or drawing.
2. Click the File menu and select See revision history.
3. Click a time stamp in the panel on the right to see a previous version of the file. You’ll also see the people who edited the file below the timestamp, and the edits that each person made is shown in the color that appears next to their name.
4. If you want to revert to the version you're currently viewing, click Restore this revision.
5. If you'd like to return to the current version of your document to continue editing, click the X in the upper right of the 'Revision history' panel.
[bookmark: h.4fxkz4xf8d11]Reverting your document to a previous version doesn’t eliminate any versions of your file, but it moves this previous version to the top of your revision history.
[bookmark: h.oiy8jlqimbxu]See edits in more detail
[bookmark: h.uxibuph832er]Revisions are grouped into short time periods to make it easier for you to see the slight differences between previous document versions. If you want to see more fine-grained revisions, click Show more detailed revisions in the lower right corner of the revision history panel.
Revision history is only available for users with “Can edit” access. Users with “Can view” and “Can comment” access are not able to see revision history.

[bookmark: h.g23305uqd77j]This is How to Download a File
[bookmark: h.h9pxvvneptat]You can download a file to your computer from Google Drive. Google Docs, Sheets, and Slides will download as converted .docx, .xlsx, and .pptx files. All other file types will download in their native format.
[bookmark: h.sohybrj4qm90]
[bookmark: h.vg28wdaz73kp]Download formats
You can download files in the following formats:
· Documents: HTML, RTF, DOCX, Open Office, PDF, Text file.
· Spreadsheets: CSV, HTML, ODS, PDF, XLSX, TXT (only for a single sheet).
· Presentations: PDF, PPTX, TXT.
· Drawings: PNG, JPEG, SVG, PDF.
[bookmark: h.hwy5i7rilw4]Downloading a file from within the file itself
[bookmark: h.pqksf8msg3bo]Drive allows you to work on an interactive Google doc and still take a “snapshot” of it at any time to open in other programs. This means that it is easy to collaborate on your Google Doc and also grab a copy at any point to use in common MS Office programs or upload to Scholar.
On a computer, you can download/export a file while you’re working on it.
1. Open desired Google doc.
2. [bookmark: h.iknu84bfzpua]Click the File menu at the far left of the menu at top of the page.
3. A flyout window will come up - click on Download as. A second menu will fly out, as shown below, with a variety of choices of document types.Choose the type of document you want your export to be and click on that file type. 
[image: Capture.JPG]
4. At the bottom of your document you will see a window pop up with an icon like the one shown below showing the document that is downloaded. [image: Capture 2.JPG]
5. Double click on the icon to open the document and then do a Save As to save the document somewhere you can find it. If you do not open the document and do a Save As, the document will be automatically saved to the default directory for downloads. For most people this is Downloads or My Documents, but the default directory for downloads can be changed. 
[bookmark: h.hqjwt0murnde]Static vs Dynamic
When you download a copy of a Google Doc, it becomes a static document. The original Google Doc is still in your Drive and is still dynamic. You can continue to make changes to the Google Doc, share it, and collaborate in real time.
The changes you make to the Google Doc after you download will not be reflected in the old downloaded copy (though you can always make a new download any time). Also the downloaded doc doesn’t have the sharing or simultaneous editing that the Google Doc has.
For these reasons, it is best to do all your editing in the Google Doc and then use download only for making static copies for reference or using in other documents.
[bookmark: h.lyem78l7kncb]This is How to Chat
When you’re working on a file at the same time as others, you can chat with the group viewing the file so that you don’t have to email back and forth while you work. Anyone viewing the file who is signed in to a Google Account will be included in the chat.
[bookmark: h.hhfux4rxddlr]Starting a chat in a file
1. Open a document, spreadsheet, or presentation.
2. Click the [image: ] button in the top-right corner of the screen.
3. Begin typing into the chat box.
4. When you’re finished, click X to close the chat window. To hide a chat in the old version of Google Sheets, click the [image: ]button again.
You won’t be able to chat if you’re not signed in to a Google Account. 
[bookmark: h.n4o8l5lv988n]Chat is a non-permanent conversation and is only visible for a short period of time. If you want a lasting record, use comments or make suggestion edits in the document.
[bookmark: h.k84ugpyj5uvf]
[bookmark: h.1s30mpbbmwwp]Turning chat sound on and off
To change the chat sound in a file:
1. Open a chat in a document, spreadsheet, or presentation.
2. Click the [image: ] gear icon in the top-right corner of the chat.
3. Check the box in the menu to turn on notifications. Uncheck the box to turn notifications off.
4. Click Save.

[bookmark: h.j2nqcxtktjg5]Tutorials:
· 2015 Google Drive Tutorial
· Using Google Drive for Student Collaboration
· Sharing and Collaborating Files in Google Drive
· Creating Comments and Suggested Edits in Google Docs
· Comments in Google Drive
· Suggested Edits in Google Drive
· Revision History in Google Drive
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